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Introduction
Address Database is a extremely powerful electronic name and
address book.  Since it is a Windows program, it is simple to use.  

Features of Address Database
Address Database allows you to:

> Store all your names and addresses 

> Store notes about each person in your address book 

> Change  and  delete  information  in  your  address  book;
Quickly find a particular person in your address book

> Undelete (restore) names previously deleted;  once you
are sure you will never need them, you may purge your
undeleted names

> Maintain a list of people you generally send holiday cards
and gifts to;  print a report of the holiday list

> Print  a  phone  list  or  address  book  of  names  in  the
address book; print them on standard paper or in Day-
Timer Jr. size

> Print  an  address  book  of  the  names;  print  them  on
standard paper or in Day-Timer Jr. size

> Print mailing labels of people you choose; print multiple
copies of these labels

> Keep a list of your file folders;  print file folder labels

> Copy a single field and paste it to another field; or copy
all  information  for  a  person  and  paste  it  into  another
application (such as Notepad, Write, Word, etc.)

> Filter  your  address  book  so  that  only  certain  people
appear (based on their category)

> Keep a "To Do List" to help you get more organized 

_____________________________________________________________________________
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> Import names and address from other applications

> Export  names and address from Address  Database to
other applications

> Merge  two  files  together  to  create  a  consolidated
address book

> Send Pragmatic Software suggestions for future releases

How to use Address Database
The main screen for Address Database contains a Summary List
which gives you a preview of the names and phone numbers in
Address  Database.    Each  time  you  click  on  a  name  in  the
Summary List, the detailed information is displayed on the bottom
half of the screen.   The total number of names is displayed along
with the total number of names that have been deleted but not
purged.

Finding a Name
To find a name in the Address Database,  click EDIT /  FIND or
press CTRL + F.  The cursor will be placed on the "Find this Last
Name" field on the screen.  Enter the "last name, first name" and
press TAB or ENTER.  The Summary List will show the first name
that matches the name entered.  If no match is found, it displays
the name that is greater than the one entered.

Applying Changes
To change information for a person, enter the new information and
press  the  "Apply  Changes"  button.   Notice  that  you  can  not
change the last or first name because they are the key to the file.
To achieve this, change the last and first name and press "Add".
Then "Delete" the original name.

Adding New Names
To add a new person,  click  on the "Clear Fields"  button.   This
clears all the fields for entry.  Enter information about the person,
including  the phone  number  if  applicable.    Once  you  enter  a
phone number and press tab, the "Primary" button for that phone
number is turned on.  This tells Address Database to to use this
phone number in the summary above.  You may change this buy
clicking the primary button for another phone number.  Once done,
press the "Add" button. 
_____________________________________________________________________________
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Deleting Names
To delete an existing person,  bring up the person by clicking on
the person in the Summary List.  Then click the "Delete" button.  It
will ask you if you really want to delete this person.  Press YES to
delete and NO to cancel.  

_____________________________________________________________________________
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Adding Notes to a Name
To add notes for a person, bring up the person by clicking on the
person in the Summary List.   Then click the "Notes" button.  Enter
notes in the Notepad and exit when done.  Each time you press
"Notes" for this person, the notes that were stored will appear.

Creating a Holiday List
To have a person appear on the Holiday List report, bring up the
person by clicking on the person in the Summary List.  Then click
the Holiday List.  Click "Apply Changes" to save the changes. 

Intelligent Zip Code
Address  Database  contains  an  "Intelligent  Zip  Code"  which
automatically enters the city and state if the zip code is the same
as any others in the database.

Intelligent Phone Numbers
Address  Database  contains  "Intelligent  Phone  Numbers"  which
automatically reformats the phone number you enter to the format
111-111-1111 x1111.  It will also convert alphabetics to numerics
(i.e. 800-94PHONE is converted to 800-947-4663).

Shortcuts
Address  Database  allows  you  to  use  the  following  keys  as
shortcuts.  By pressing these keys, the function is automatically
executed.  (CTRL + LETTER means to hold down the CTRL key
and press the letter.)

> File New CTRL + N
> File Open CTRL + O
> File Save As CTRL + S
> Copy Field CTRL + C
> Paste CTRL + V
> Find Name CTRL + F
> Undelete CTRL + U
> Print Mailing Labels CTRL + M
> View All Names CTRL + A
> Filter Names CTRL + I
> To Do List CTRL + T
> Help F1

_____________________________________________________________________________
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Hardware Required
Address Database is designed to work with:

> IBM  286  or  higher  compatible  computer  running
Microsoft Windows version 3.0 or higher

> A monochrome or color EGA, VGA, or better monitor
> A hard disk
> 1 Megabyte of memory
> Any type of printer
> Windows Notepad (installed)
> Windows Write (installed)

Installing Address Database
To  install  Address  Database,  run  SETUP.EXE.   Or,  to  install
Address Database manually,  following these steps:

1. Put the floppy diskette containing Address Database in
the a: or b: drive.   

2. Create a new directory on your hard drive for Address
Database.  (i.e.   C:\ADDRDB).  You can do this by using
Windows File Manager (FILE / CREATE DIRECTORY...).

3. Copy  all  files  from  the  floppy  to  the  new  Address
Database directory on the hard drive.   Again,  use File
Manager (FILE / COPY).  Copy all files (i.e. *.*).

4. Create an icon in Program Manager so that you can run
Address Database by double clicking the icon.  Do this
by  using  Windows  Program  Manager  (FILE  /  NEW  /
PROGRAM ITEM / DESCRIPTION (Address Database) /
COMMAND  LINE  (C:\ADDRDB\ADDRDB.EXE)  /
WORKING  DIRECTORY (C:\ADDRDB)   /  SHORTCUT
KEY (CTRL +  ALT  +  A).   This  will  allow  you  to  run
Address  Database  by  double  clicking  the  icon  or
pressing  CTRL +  ALT +  A).   Note:  If  you  would  like
Address Database to automatically open a file when it
begins, make the WORKING DIRECTORY (C:\ADDRDB
filename.adb).

5. For a detailed description of all the files used by Address

_____________________________________________________________________________
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Database, read INSTALL.TXT.

_____________________________________________________________________________
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FILE MENU
The File  Menu in  Address Database allows you to create  new
files, open existing files, import a file, export a file, merge two files
together, and exit Address Database.

New (Create a new file)
To create a new Address Database file, click FILE / NEW or press
CTRL + N.  It will prompt you for a file name.  Enter the name of a
file that is not currently being used.  The extension of the file name
must be ".ADB" (i.e. NEWFILE.ADB).  Press OK to create a new
file or click the CANCEL button to cancel the operation.  

Open (Open an existing file)
To open an existing Address Database file, click FILE / OPEN or
press CTRL + O.  It will  display a list of files.  Click on the file
name you wish to open.  Click OK to select the file or  click the
CANCEL button to cancel the operation.  

When  you  initially  start  Address  Database,  it  automatically
remembers the last file you had open, and will open that file.  

Optionally, you may automatically open a specific file each time
Address Database is started by setting the properties in Program
Manager to pass Address Database the file name.  For example,
to open myfile.adb each time you execute Address Database, set
up  the  properties  in  Program  Manager  as   C:\ADDRDB\
ADDRDB.EXE MYFILE.ADB.

Close (Close an open file)
To close the file that is currently displayed in  Address Database,
simply open a new file.  It automatically closes the opened file.  

Save As (Save the file as a new name)
To save the currently opened file as a new name, click FILE / 
SAVE AS or press CTRL + S.   Notice that only the records 
currently in the Summary List are saved.  This allows you to 
_____________________________________________________________________________
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"Filter" the list saving only the filtered names as the new file.   Of 
course, you may do a  VIEW / ALL and a FILE / SAVE AS to save 
all names in the file to a new name.

_____________________________________________________________________________
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Import (Importing a file into Address Database)
To import a file into  Address Database, click FILE / IMPORT.   A
screen will be displayed that allows you to let Address Database
know the layout of the import file.  This screen also has a list of
instructions at the top of the screen.  To cancel the import, click
the CANCEL button.

To import a file you must do the following:

> Create the import file in comma-delimited format.  Make
sure  that  the  file  resides  in  the  same  directory  as
Address Database.  

> Enter the "Import File Name" and "File Name to Create".
The "File Name to Create" should have an extension of
".ADB" (i.e. NEWFILE.ADB).  

> Choose the fields that appear on the Import file in the
order in which they appear on the file.  Do this by clicking
each field name in the order as it  appears on the file.
Once you click it, you will see it move to the box on the
right.  If a field name is on the Import file but not in the
list, click on the UNDEFINED field name.

> If you make a mistake,  click the RESET button.

> Click  the  IMPORT  NOW  button  to  begin  the  Import.
Once imported, a record count will be displayed.  

Note that Address Database does not allow duplicate records, so 
if the imported file has duplicates, the duplicates will be deleted.  

Also, Address Database will store all phone numbers in 111-111-
1111 x1111 format.

_____________________________________________________________________________
_

Pragmatic Sofware Co.  / 6728 Bellehave Drive / Plano TX 75023        -        Page 13



Address Database 1.1                                                                        User's Help Guide
_____________________________________________________________________________

Export (Exporting a file for other applications)
To export a file from Address Database, click FILE / EXPORT.  It
will prompt you for a file name.  Enter the name of a file that is not
currently being used.  Press OK to create a new file or press the
CANCEL button to cancel the operation.  

Once the file is exported, it will prompt you to ask you if you would
like a report showing the layout of the exported file.  The report
contains the file  name exported,  the number  of  records,  and a
record layout of the exported file.  Press YES to print the report
and NO to exit.  The exported file is created in comma-delimited
format.

Merge (Merging two files together)
To merge 2 files together in Address Database, open the file that
will  contain  the names after  the  merge.   Then click  on FILE /
MERGE.  It will display a message telling you that a backup of the
original file will  be created and named "*.BAK", where * is your
original filename.  Press OK.

It will prompt you for a file name.  Click on the file name of the file
to merged with the one that is currently open.  Press OK to merge
the two files or press the CANCEL button to cancel the operation.  

Exit (Exit Address Database)
To exit Address Database, click FILE / EXIT.  

_____________________________________________________________________________
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EDIT MENU
The Edit Menu in Address Database allows you to copy a field,
copy all  information (name, address, etc.),  paste a copied field,
find a particular name, undelete a previously deleted name, purge
the deleted names.

Copy Field (Copy information to Clipboard)
To copy a field on the screen, put the cursor on the field and click
EDIT / COPY FIELD or press CTRL + C.  The contents of the field
will be copied and placed into the Windows Clipboard.

Copy All Information (Copy Name/Address,Etc.)
To  copy  the  name,  address  and  phone  number  of  the  name
currently displayed, click EDIT / COPY ALL INFORMATION.  The
information will be copied and placed into the Windows Clipboard.
The copied text is formatted so that it can be pasted into a word-
processor or text-editor.  An example of what the results look like
are:

Bruce Lee
HardFoot, Inc.
999 Roundhouse Street
Plano, TX  75023
214-144-9864 (Home)

Paste (Paste information from Clipboard)
To paste  a  copied  piece  of  information,  put  the  cursor  on  the
receiving field and click EDIT / PASTE or press CTRL + V.  The
contents of the field will be pasted into the field.

Find (Find a last name)
To find a name in the Address Database,  click EDIT /  FIND or
press CTRL + F.  The cursor will be placed on the "Find this Last
Name" field on the screen.  Enter the "last name, first name" and
press TAB or ENTER.  The Summary List will show the first name
that matches the name entered.  If no match is found, it displays
the name that is greater than the one entered.

_____________________________________________________________________________
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Undelete (Recover deleted information)
To undelete a previously deleted name in the Address Database,
click EDIT / UNDELETE or press CTRL + U.   It  will display all
names that are available to be undeleted.  Double Click the name
to undelete.  

Once  double  clicked,  <<UNDELETE>>  appears  next  to  the
record.  Double click again to turn off <<UNDELETE>>.   To turn
off all <<UNDELETE>>, press the RESET button.  To undelete the
items marked <<UNDELETE>>, click the UNDELETE AND EXIT
button.    Click  on  CANCEL  to  cancel  the  operation  without
undeleting any named.

Purge Deletes (Get Rid of Undeletes)
To purge the deleted names in the Address Database, click EDIT /
PURGE  DELETES.    It  will  physically  delete  from  the  file  all
records marked as deletes.  Notice that the new Delete Count is
zero.  Once this is done, an Undelete can no longer be done on
those names that were purged

Purge Deletes on Exit
To purge the deleted names in the Address Database every time
you  open  a  new  file  or  exit  Address  Database,  click  EDIT  /
PURGE DELETES ON EXIT.   It will physically delete from the file
all records marked as deletes each time you open each new file or
you exit Address Database.  

_____________________________________________________________________________
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LABELS MENU
The Labels Menu in Address Database allows you to select the
type of printer you use (Laser or Dot Matrix), find out what types of
address labels to purchase, obtain mailing label instructions, print
mailing labels, and print file folder labels. 

Laser Printer Labels (Avery 30 per page)
Click on this if you are using a Laser Printer to print your mailing
labels.  Once clicked, a check mark will appear next to this.

This  assumes you have purchased  Avery  Laser  printer  mailing
labels, 3 across,  30 address labels per page.  

Dot Matrix Printer Labels (Avery 36 per page)
Click on this if  you are using a Dot Matrix Printer  to print  your
mailing labels.  Once clicked, a check mark will  appear next to
this.

This assumes you have purchased Avery model 4144, continuous
form printer mailing labels, 3 across,  36 address labels per page,
2 1/2 x 15/16 label size, 9 1/2" form.

Type of Labels to Purchase
This describes the type of address labels to be used with Address
Database.   It  displays  the  following  information  and  may  be
printed by pressing YES at the prompt:  (You can print this and
take it to the supply store.)

> Laser Printer - 8 1/2 x 11 form width
3 labels across
30 labels per page

> Dot Matrix - 9 1/2 form width
3 labels across
36 labels per page
2 1/2 x 15/15 label width
Avery Model 4144

_____________________________________________________________________________
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Mailing Label Instructions
This describes how to print mailing labels:

> Click on menu to choose type of labels  (Laser Printer
Labels or Dot Matrix Printer Labels). 

> Put address label paper in printer:
Laser Printer Labels - Use Avery 30 per page
Dot Matrix Labels - Use Avery 36 per page

> Filter the list so that it displays only the names you wish
to create labels for.  Hint: Use VIEW / FILTER or press
CTRL + I.  To print a single label multiple times, VIEW /
FILTER the label to print, and enter 30 or 36 to print a full
page of labels for this name.

> Use the LABELS / PRINT MAILING LABELS command,
or press CTRL + M, to begin printing.  

File Folder Instructions
This describes how to print  file folder labels.  Notice that when
these are printed, up to six fields are printed on the file folder label
(last name, first name, company, title, address1, and address 2).
To print file folders:

> Click  on  the  Labels  Menu  to  choose  type  of  labels
(Laser Printer Labels or Dot Matrix Printer Labels).   Click
on the type of printer you have.

> Put address label paper in printer:
Laser Printer Labels - Use Avery 30 per page
Dot Matrix Labels - Use Avery 36 per page

> Filter the list  so that it  displays only the names with a
category of FILEFOLDER.  Hint: Use VIEW / FILTER or
press CTRL + I.  More simply, click YES at the prompt
and it will automatically filter them for you.

> Use the LABELS / PRINT MAILING LABELS command,
or press CTRL + M, to begin printing.  

_____________________________________________________________________________
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REPORTS MENU
The Reports  Menu  in  Address  Database  allows  you  to  print  a
phone list,  address book,  holiday list  of  names and addresses,
and choose whether to print on standard or Day-Timer  Jr. paper.

Print Phone List
Click  on  this  to  create  a  phone  list  of  all  names  currently
displayed.   Notice  that  you  can  print  a  phone  list  of  selected
names  by  first  "Filtering"  the  list  and  then  printing  this  report.
Once done, the total number of names printed is displayed.

Print Address Book
Click on this  to  create an address book of  all  names currently
displayed.  Notice that you can print an address book of selected
names  by  first  "Filtering"  the  list  and  then  printing  this  report.
Once done, the total number of names printed is displayed.

Print Holiday List
Click on this to create an address book of all names that have the
Holiday List field clicked.  

To have a person appear on the Holiday List report, bring up the
person by clicking on the person's  name in  the Summary List.
Then click the Holiday List.   Click "Apply Changes" to save the
changes. 

Print on Day-Timer Jr. Paper
Click on this to print the report on Day-Timer Jr. paper.  This will
skip a few lines at the top of the page and the total line count of
the report will be less than the standard paper.  Notice that once
this is clicked on the menu, a check mark appears next to it.  To
turn this off, click it again.

_____________________________________________________________________________
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VIEW MENU
The View Menu in Address Database allows you to view all names
in  the  currently  displayed  file  or  filter  the  display  so  that  only
certain categories are displayed.

All (View all names in currently opened file)
Click on this to take off all filters.  This will display all names in the
opened file.

Filter (View particular names based on category)
To display only names that have certain categories, click VIEW /
FILTER or press CTRL + I.   When clicked, it displays a screen
that allows you to choose the categories to include in the display.
To cancel, click the CANCEL button.

Notice that the screen has detailed instructions on filtering:

> Choose  the  categories  that  appear  in  the  AVAILABLE
CATEGORIES box.  Once you click a category, you will
see it move to the box on the right.  This means that this
category will be included. 

> If you make a mistake, click the RESET button.

> Click  the  FILTER  NOW  button  to  filter  based  on  the
categories selected.

_____________________________________________________________________________
_

Pragmatic Sofware Co.  / 6728 Bellehave Drive / Plano TX 75023        -        Page 21



Address Database 1.1                                                                        User's Help Guide
_____________________________________________________________________________

TOOLS MENU
The Tools Menu in Address Database allows you to display a To
Do  List,  send  the  author  suggestions,  and  purchase  Address
Database (if you are not a registered customer).

To Do List
To open a To Do List, click TOOLS / TO DO LIST or press CTRL +
T.   When clicked, it prompts you for a To Do List file name.  If one
is not found, a sample one is created, named SAMPLE.TOD.  

Use this To Do List each day to record the things you must do
each day, in the future, and to record things that have been done.
At  the  end  of  each  day,  you  may  want  to  save  the  file  as
something  that  you  can  remember,  such  as  the  date.   For
example, you may want to save it as ME010193.TOD which says
it is for "ME", for the date of "010193".   

Make sure you save it with an extension of ".TOD" to let Address
Database know that it is a To Do List.  The To Do List uses the
Windows Notepad and may be printed.

Suggestion Box
To send me a suggestion or to register a problem, click TOOLS /
SUGGESTION BOX.   When clicked, it creates a letter in Notepad
named SUGGEST.TXT.  

Enter  your  name  and  address  and  enter  suggestions  for  new
releases.  You may also use this to identify problems you find with
Address Database.   Print  the letter  and send it  to the address
listed.  Letters will be given prompt attention.

Purchase Address Database
To  purchase  a  copy  of  Address  Database,  click  TOOLS  /
PURCHASE ADDRESS DATABASE.   When clicked, it creates a
letter in Notepad named PURCHASE.TXT.  

Enter  your  name and address and enter  the order  information.
Print the letter and send it to the address listed.  New orders will
be given prompt attention.
_____________________________________________________________________________
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Notice that registered customers will not have this as a menu item.

_____________________________________________________________________________
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HELP MENU
The Help Menu in Address Database allows you to display this
user's guide and display information about Address Database and
it's author.

Address Database User's Guide
Press F1 or click HELP / ADDRESS DATABASE USER'S GUIDE
to display the information that you are reading right  now.  This
information  is  stored  in  Windows  Write  and  is  named
ADDRDB.WRI.    

You may print this for a hard-copy of the manual.  You may use
this as you use Address Database to get help on specific topics.
Use the Windows Write "Find" command to find topics or use F4
(Find / Go To Page...) to jump to a particular page.  

About Address Database
Click HELP / ABOUT ADDRESS DATABASE to display the name
of  the  software,  the  version,  copyright  information,  address  for
purchasing and the purchase price.
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